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1.1. What is FishStatJ

FishStatJ is a desktop application to disseminate statistical data to users; in particular FAO Fishery
Statistical data.

It started in the early 1990’s, with the first release of FishStatPlus which was designed to run on
DOS; used to disseminate Fishery statistical datasets for download and on CD-ROM. At the CWP
(Coordinating Working Party on Fishery Statistics) meeting in 2005 the limitations of the DOS-
based FishStatPlus were discussed (details: http://www.fao.org/fishery/topic/18238/en).

With the release of Windows Vista; it was clear that an upgrade was needed, and development of
the next generation FishStatJ started in 2008. The name FishStatJ was selected, because FishStatJ is
developed using Java technology. At the 23" CWP meeting (2010) the prototype of FishStatJ was
endorsed for full development; and the first release of FishStatJ was delivered in 2011.

FishStatJ was designed to improve on the features of FishStatPlus:

All Fishery reference data is available (all FAO code lists with all attributes)
All hierarchies are available (for view, and for filtering/aggregation)
Graphing and charting functions of FishStatPlus are included

Calculated columns of FishStatPlus are included

The software is cross-platform (Windows, Macintosh, LINUX)

Data (workspaces) of dimensions can be defined as needed (flexible)

Any data with fixed dimensions and yearly resolution can be loaded

For the creation of workspace files (database files); a separate software called FishStatJ Console
was developed.

In order to use the statistical data, the user has to download and install the FishStatJ application
on his computer (more details follow).
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1.2. Installing on Windows

Download the Windows application http://www.fao.org/fishery/statistics/software/fishstatj/en.

FishStatJ runs on Windows 7, 8 and 10 (64-bit only). It requires Java 8 to be installed on the
computer http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-
2133155.html (the Installer is called Windows x64 Offline). FishStatJ requires at least 4GB of
RAM.

To install on Windows, the ZIP-download must be extracted into a directory where the user has
update permissions. We recommend to unzip the program to the C-disk (C:\FishStatJ) or leave the
unzipped FishStatJ folder on the Desktop.

It is very important when extracting to maintain the zipped file structure; with all the
required FishStatJ subdirectories!

The first step is to extract (copy) the content of ZIP file into the root folder of the C: disk, or extract
onto the Desktop:

@Uv| 1, <« Downloads | FishStat) 2125 win32.zip » - |¢,|

File Edit WYiew Tools Help

Organize « Extract all files
- Favorites o s
W U=Rer —i _ File fole
4. Downloads
+ Copy to Desktop | l-'_ Recent Places

Note: To extract files into C:\ProgramFiles\ requires Administrator permissions.

Then, run FishStatJ from the extracted folder:

—— — g S
A Q‘\Esers\bergEr\DeslctDp\FishStatl ‘\

File Edit View Tools Help extracted folder

Organize = Open Burn MNew folder

r Favorites *  Mame Size Type
B Deskiop J cenfiguration File folder
4 Downloads J Jre File folder
5| Recent Places | plugins File folder
m2 = S2KB Application
) IATTC 4 FishStatlini 1 KB Configuration settings

The next step after expanding the application ZIP file is to download workspaces; please refer to
“Browse Workspace ...” in chapter 2.1.
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If you cannot run 64-bit applications, you can continue to use FishStatJ 3.02. Contact us (refer to
chapter 8.6) if you wish to download this version.

Create a shortcut on the Desktop

To create a shortcut on the Desktop, select FishStatJ.exe and drag it onto the Desktop while holding
the [CTRL] and [SHIFT] keys (when simultaneously holding down both keys the mouse pointer
changes into shortcut arrow):

iy

Computer

k;fk:,j [ » FishStat) »

File Edit View Tools Help

Organize = Open Burn Mew folder

-~

. Favortes Mame
B Desktop configuration
4 Downloads ire

“| Recent Places plugins

# Create link in Desktop |,

product

| B4 FishStat).exe

ik | FishStatlini

Applications can be added to the task-bar (usually on the bottom of the screen); by right-clicking on
the icon in the task-bar while the application is running: select “Pin this program to taskbar”.

1.2.1 Windows troubleshooting (companion library)

If you receive the message: “The FishStat] executable launcher was unable to locate its companion
shared library”, this happens when FishStatJ was run from inside the ZIP file; the solution is to
extract the ZIP file content as described above.

1.2.2 Windows troubleshooting (Java tips)

e You can download the Version 1.8 JRE from the URL in chapter 1.2 Installing on Windows.

e To un-install a previous version of Java, follow these instructions:
https://www.java.com/en/download/help/uninstall_java.xml.

e For troubleshooting the Java version, check that the JRE was added to the PATH, and that
the JAVA_HOME environment variable is pointing to the JRE installed. One can verify
these settings, by running the command “java -version” from a DOS window.
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1.2.3 Windows troubleshooting (No Java Environment available)

[ Fishstat! |

A Java Runtime Environment (JRE) or Java Development Kit (JDK)
must be available in order to run FishStat), Mo Java virtual machine
was found after searching the fellowing locations:
CahUsers\bergerDesktop' FishStathjre\bin'javaw. exe

javaw.exe in your current PATH

L Ok

The solution is to install Java JRE (refer to Java tips above)

1.2.4 Windows troubleshooting (Wrong version Java)
( Incompatible JWM @

Yersion 1.7.0_71 of the J¥M is not suitable for this product. Version: 1.8 or greater
is required.

Ok

To have the correct version activated, we suggest to un-install the older Java JRE, then re-install
Java 1.8 JRE (refer to Java tips above).

1.2.5 Windows troubleshooting (failed to load jvm.dll)

If you receive the message: “Failed to load JNI shared library vml.dIl”’; the Java run-time installed
and activated is 32-bit; FishStatJ requires 64-bit Java run-time.

-

[ FishStat] ==

Failed to load the JMI shared library "C\Program Files
(86 avajrel B.0_45\bin\client\jvrn.dll”,

Ok

The solution is to install JRE 1.8 64-bit (refer to Java tips above); the 32-bit JRE can remain
installed on the computer.
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When launching FishStatJ.exe on Windows10; a dialog appears informing the software is from an
unknown publisher. Please select “Yes” to continue launching the application.

9 User Account Control

Program name:
Publisher:
File origin:

Show details

Do you want to allow this app from an unknown
publisher to make changes to your PC?

C:\FishStatJ\FishStatd .exe
Unknown
Hard drive on this computer

Change when these notifications appear

X

1.2.7 No Internet connection
When the download of the auto-update information fails, FishStatJ produces the following warning:

&4 FishStat) is working off-line

Fish5tat) cannot connect to http:/fwww.fac.org, and as a result
a check for application updates and download of data is not possible.

Only workspaces installed previously are available,

To fix this, please connect to the internet or update firewall settings.

(]

If there is no internet connection possible — the notification of a new program version is not
available, and no workspaces are shown for automatic download. In this case the manual can only
be opened if it was previously downloaded.

Refer to chaper 8.5 for a description of the auto-update notification, and a description of what data
is downlaoded from the internet.
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1.3. Installing on MacOS

Download the OSX application http://www.fao.org/fishery/statistics/software/fishstatj/en. After
extracting, the FishStatJ application can be directly run from the Desktop, or moved to the
Applications folder. It requires at least 4GB of RAM.

FishStatJ runs on OSX 10.9, 10.10 and 10.11. It requires Java 8 to be installed on the computer
http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html.

As FishStatJ is an application which is downloaded from the FAO web-site; the OSX security needs
to be adjusted in System Preferences -> Security & Privacy in order to allow applications from
identified developers:

O 4 Y Security & Privacy o]

m FileWVault  Firewall  Privacy

A login password has been set for this user =~ Change Password...
Require password immediately ﬁ after sleep or screen saver begins

Show a message when the screen is locked

Disable automatic login

Allow apps downloaded from:

Mac App Store

@App Store and identified dev@

 Anywhere

Glick the lock to prevent further changes. Advanced...

The next step is to download workspaces; please refer to “Browse Workspace ...” in chapter 2.1.
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1.3.1 MacOS troubleshooting:

If you receive the message: “Out of memory”, when you open a dataset, this happens when the Java
Runtime was migrated from an older macOS version; and is not updated. You can check the Java
version installed using Terminal “java —version”.

We recommend Java 1.8 (Java8); this is the version against which we test the application. We found
that to update from Java 1.6, you need to install the JDK 1.8:
http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
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1.4. Workspaces (statistical data)

Workspace files carry the statistical data. While there is no limit how many workspaces can be
installed on a computer, FishStatJ can only work with one workspace at a time.

A workspace can contain one or more datasets. For dissemination of data, workspaces are
compressed into workspace files (.wks extension); they are downloaded automatically by FishStatJ.

We currently offers 4 different workspaces files, which contain the following datasets:

e The Global Production workspace which contains:
o Global Production
o Capture Production
o Aquaculture Production
e The Regional workspace with contains:
o CECAF (Eastern Central Atlantic)
o GFCM (Mediterranean and Black Sea)
o RECOFI capture production
o SEATL Southeast Atlantic Capture Production
e The Food Balance workspace which contains:
o Food Balance Sheet
o Population data
e The Commodities workspace which contains:
o Fisheries Commodities Production and Trade

Please refer to Browse workspace... (below) for importing workspaces into FishStatJ.
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2. Dataset Menu

2.1. Browse workspace...
The browse workspace menu allows to manage the workspaces:
e Open workspaces already installed

e Download and install workspaces (from the FAO web-page)
o Delete workspaces installed on the computer

4 FishStat)

I Dataset | Edit Data View Tools
Open dataset... cti+0 || | Bl o %
Open workspace... 2
Browse workspace... Ctrl+W

Close workspace

Exit

O) Food and Agriculture

h

/ of the United Nations
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e Workspaces in red color, are not installed on the computer (also if there is a new version

available)

e Workspaces in blue color are installed on the computer

Example of a workspace data version 2016.1.0 installed on the computer

&+ Workspaces browser

Fish5tat) workspaces browser

Open a workspace already installed or import a new one,

Marne
FAOQ Global Fishery and Aguaculture Statistics
FAQ Regional capture fisheries statistics

FAQ Global Fishery and Aquaculture Statistics

Acronym  FAQ_FL GLOBALS Yersion 2016.1.0
Mame FAQ Global Fishery and Aquaculture Statistics
Description FAOQ Global Fishery and Aquaculture Statistics
Provider Food and Agriculture Organization of the United Mations

Location | Ch\Users\bergerfishstat]_workspacetws_ 0000

(]

Download

Close

-

An installed workspace can be opened for viewing the data, or deleted (removed) from the

computer.

Manually download workspaces can be imported using the Import button.

Workspaces already installed, are not be shown as available for download.
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Example of a new updated version of an already installed workspace is available for download:

-

4 Workspaces browser @

Fish5tat) workspaces browser

Open a workspace already installed or import a new one.

Name Open...

FAQ Global Fishery and Aquaculture Statistics
] Delete

FAOQ Regional capture fisheries statistics
FAQ Global Fishery and Aquaculture Statistics ‘

Acronyrm FAO _FI_GLOBALS Yerzion 2016.1.2
Marne FAQ Global Fishery and Aquaculture Statistics

Description |Internet: autematic download

Provider http:/ v fac.org/fishery/static/Fish5tat)
Location FFAC_FI_Global_2016.1.2 fws

Cloze

Clicking on the download button will open the workspace import wizard:
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e "

= E=8(ECR ™<=

Fish5tat) workspace download M
(1) The download is complete

http:/ S www.fao.org/fishery/static/FishStat)/FAOQ_FI Regionals_2016.1.0.fws
Download location:

Ch\Users\berger\Desktop\FAOQ_FI_Regionals_2016.1.0.fws

< Back Ned> )| Finich

A progress bar appears during the download

Downloading workspace
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e

=

Fish5tat) new workspace import

(1) The selected file is a valid workspace file. Press "next” to install it on your computer.

File selected |C\Users\berger\Desktop\FAC_FI_Regionals_2016.1.0.fws

Workspace metadata
Acronym  FAO_FI REGIOMAL WVersion 2016.1.0
Mame FAQ Regional capture fisheries statistics

Description FAOQ Regional capture fisheries statistics
Provider Food and Agriculture Organization of the United Mations
Location Ch\Users\berger\Desktop

Firish

Cancel
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In case an older version of the data is already installed, FishStatJ will ask if the new version should
overwrite the old version — or keep both (resulting in two versions of the same data installed).

I

Fish5tat) new workspace import

Check workspace §
&

File selected  C\Users\berger\Desktop\FAQ_FI_Regionals_2016.1.0.fws

Workspace metadata
FAO_FI REGIOMAL
FAQ Regional capture fisheries statistics

Acronyrm Version 201610
Mame

Description FAO Regicnal capture fisheries statistics

Provider Food and Agriculture Organization of the United Mations
Location C\Users\bergerDesktop
Warning!

This workspace is a different version of an already installed one, You can choose to overwrite the
previous workspace with this one (recommended), or keep both of them.

| Ohwerwrite
@ Keep both

T
< Bacl Next> ) B
e —

o [-2-f]

[
Wi

i
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During the workspace installation progress is shown:

Workspace installation

When the installation is complete

e "

Fish5tat) workspace import
(1) The workspace installation is complete

Workspace metadata
Acronym  FAO_FI_REGIOMNAL Wersion 2016.1.0
Mame FAQ Regional capture fisheries statistics

Description FAOQ Regional capture fisheries statistics
Provider Food and Agriculture Organization of the United Mations
Location C\Users\berger\Desktop

e —

< Back Mext = q Finish P Cancel |

The workspace file which is downloaded on the Desktop can be deleted after importing.

After clicking on Finish, the workspace browser opens (refer to “Open dataset...”) below.
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2.1.2 Browse workspace (delete)

This will show the workspace browser dialog; which allows you to manage the workspaces
installed on your computer:

-

4 Workspaces browser @

Fish5tat) workspaces browser

Open a workspace already installed or import a new one.

>,
FAQ Global Fishery and Aguaculture Statistics  gf— —
Import...

FAQ Regional capture fisheries statistics l‘
FAQ Global Fishery and Aquaculture Statistics

Acronyrm FAO _FI_GLOBALS |‘u‘er5i|:|r1 2016.1.0 | /
Marne FAQ Global Fishery and Aquaculture Statistics I

Description  FAQ Glebal Fishery and Aquaculture Statistics

Provider Food and Agriculture Organization of the United Mations
Location ChUsersh\berger\fishstatj_workspaceiws_0000

)

Selecting a workspace will show metadata for this particular workspace (Acronym, Version, Name,
Description, Provider, and location on disk). The selected workspace is permanently removed from
your computer when you click on the Delete button.

2.1.3 Browse workspace (import)
The “Import...” buttons allows to import manually downloaded workspaces.

Normally, workspaces are downloaded by FishStatJ, so there is no need to manually download a
workspace file.
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2.2. Open Dataset...

NOTE: This option is only available if a workspace has already been opened
&4 Fishstat) - FAO Global Fishery and Aquaculture Statistics

Edit Data View Tools

Open dataset... Ctrl+0 | o 8
Open workspace.., k
Import workspace... Ctrl+Shift+W

Close workspace

Exit

Selecting this option will present the Dataset selection popup window where datasets may be
opened and brought into FishStatJ for viewing.

Once you have opened a dataset, the Open workspace menu is disabled (will disappear); until you
Close the active workspace

ﬁ Datatset browser EI@

Datatset browser

Select a time series or a complete dataset g \“:’
% E
is,f R

Dataset Metadata | Dimensions | Attachments | time series
4 | Global capture production Name Giobal capture production
Cluantity (1850 - 2013) Acronym CAPTURE Date 2017-03-07
4 Global aguaculture proeduction Data source FAD
Quantity (1950 - 2015} URL http:/fwww. fan. org ffishery/statistics fglobal-capture-productionfen
Walue (1984 - 2015) i ) ) . -
Description This database contains capture production statistics by country or

4 Global production by preduction source
Cuantity (1950 - 2015}

territory, species item, and FAQ Major Fishing Area.

[ ok || Canced |

Selecting a dataset with mouse clicks will present the relevant metadata. Select a dataset and click
on the 'OK' button to open the dataset content.
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e

Dataset Edit

@ 7%

Data

Country (Country)
i Afghanistan Freshw
Albania Angels
Albania Atlanti
Albania Atlanti
Albania Barracy
Albania Bighea
Albania Bleak
Albania Blue ar
Albania Blue wl
Albania Bluefis|
Albania Bogue
Albania Cararmu
Albania Catsha
Albania Comm
Albania Comm
Albania Comm
Albania Comm
Albania Comm
Albania Comm
Albania Comm
] m b
Measures

1950 100 1951

1956 200 1957

-

View Tools

& fv [E] |iii > | B o

Specie: * 2006

1000 F
55

30
7

402
18

86
102

430
86

40
82
43

4

100
200

2007

1000 F
12

19
24
504

132
18

435
47
27
82
63

1952
1953

¢ Fishstat) - FAOD Global Fishery and Aquaculture Production Statistics

2008 2008
1000 F 1000 F
23 14
- 50
27 21
24 5
190 530
132 154
23 20
vl 214
62 126
8 4
32 43
82 109
63 64
100 1953
200 1959

Record no. 1 of

2010

1000 F
78

23
7

505
&0
278
335F
0a
25
47
120

100
200

2011
1000 F

12
aa
12
23
360

88
450
an
22
113
68

1954
1960

2012
1000 F

5

5
12
201

129
290

214
125
143
165

79

100
200

2013
1000 F

5F
9
4F
11F
175 F

128 F
330F
196 F
112 F

5F
130 F

170 F
62 F

1955
1961

21583 filtered records -

=N [R5

QLI“'!! - E

2014
1000 F

4
34
3

10

150

126
367

178
a9
1m
173
44

200
300

1Ll

. e
1000 F
4F
41
27
16
200

108
17
27

115

5F
15

124
1.

= 0O

-

3IM ot 705M (T

-

Highlighting a row (as shown above) will present the yearly data values below (as shown under the

Measures tab)
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&4 Fishstat) - FAOQ Global Fishery and Aquaculture Statistics

Edit Data View Tools

Open dataset... Ctrl+0

Import workspace... Ctrl+Shift+W

Close workspace

|= | B &%
2014) 23
ching area (FAC ..

ia - Inland waters

editerranean an...

Exit
Albania Atlantic bluefin tu...
Albania Atlantic bonito
Albania Barracudas nei
Albania Bighead carp
Albania Bleak

Mediterranean an...
Mediterranean an...
Mediterranean an...
Eurcpe - Inland w...

Europe - Inland w...

g

Measure (Measure)

Quantity (tonnes)
Quantity (tonnes)
Quantity (tonnes)
Quantity (tonnes)
Quantity (tonnes)
Quantity (tonnes)
Quantity (tonnes)

= 1987
0001

Selecting this option will close the current workspace and all datasets and that are active within this

workspace.

Note: Close workspace will record all active datasets, so they are automatically re-opened next time
you launch FishStatlJ. If you don’t want a dataset to be recorded as open, just close it using the close

box on the dataset panel:

Dataset Edit Data View Tools

@Y%

Country (Country) Species (ASFIS spe..

Afghanistan Freshwater fishes ...

Albania Angelsharks, sand...
Albania Atlantic bluefin tu...
Albania Atlantic bonito
Albania Barracudas nei
Albania Bighead carp
Albania Bleak

Albania Blue and red shrimp

&4 Fishstat] - FAOQ Global Fishery and Aquaculture Statistics

= 1987 ——oag
Close
000 F~1omF

R LENEREEY L

{1 Glebal capture production - Quantity (1950 - 2014

19a9
1000 F

1940
1100 F

1991
1100 F

1992
1200 F

1993
1200 F

Note: Filtering and Aggregation settings are also recorded for each dataset; and automatically re-
applied when you launch FishStatJ next time.

If 'Save working session on exit' in the Preferences (submenu item under Tools) is selected, the
datasets that were open when the Exit was selected will be automatically reloaded when FishStatJ

restarts
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2.4. Exit
DRkt

Dataset | Edit Data View Tools

Open dataset... Ctrl+0 z | N - |
Open workspace... L
Irnport workspace... Ctrl+Shift+W

Close workspace

Exit

Selecting this option will exit the FishStatJ program.

Page 23 of 68

Version 3.03.2
Nov 2017



FishStatJ Manual

Version 3.03.2

Nov 2017
3. Edit Menu
[@] Fishstaty = -1o] x|
Dataset | Edit Data Yiew Tools Help
hloz|ga%8 |0
i e Save selection (*.csv file)... l production - Quantity {1970 - 2008) [ .| Global aquaculture production by quantity and value - Production {1950 - 2009) ;23- N =]
Country (Country) | Species (ASFIS spe... | Aquaculture area (F... 4| 1950 | 1951 | 1952 | 1953 | 1954 | 1955 | 1956 | |
Albania Common carp Eurape - Inland wat.., — —'
Albania Common carp Europe - Inland wat... ]
Albania Crucian carp Europe - Inland wat. ..
Albania Crucian carp Europe - Inland wat. ..
albania Freshwater fishes nei  Europe - Inland wat. ..
Albania Freshwater fishes nei ~ Europe - Inland wat...
Albania Gilthead seabream Mediterranean and ...
Albania Gilthead seabream Mediterranean and ...
Albania Grass carp(=White ... Europe - Inland wat...
Albania Grass carp(=White ... Europe - Inland wat...
Albania Kuruma prawn Mediterranean and ...
Albania Kuruma prawn Mediterranean and ...
Albania Mediterranean mussel  Mediterranean and ...
Albania Mediterranean mussel ~ Mediterranean and ...
Albania Mullets nei Europe - Inland wat.
trout . . . . . .
chang b n
Wuchang bream Europe - Inland wat.
Algeria Caramote prawn Mediterranean and ...
Algeria Caramote prawn Mediterranean and ...
Algeria Common sole Mediterranean and ...
Algeria Common sole Mediterranean and ...
Algeria Cyprinids nei Africa - Inland waters
Algeria Cyprinids nei Africa - Inland waters
Algeria European eel Africa - Inland waters
Algeria European eel Africa - Inland waters 1
Algeria European seabass Mediterranean and ...
Algeria European seabass Mediterranean and ... 1
Algeria Freshwater fishes nei  Africa - Inland waters 1
Algeria Freshwater fishes nei  Africa - Inland waters ¥ v
kil o 4l | »
Measures\ =0 I
&
1950 1951 [ 1952 1953 1954 1955 1956 1957 1958 [ :|
1959],,, 1960],,, 1961[,,_ 1962',,, 1963[,_, 1964].,, 1965],,. 1966',,, 1967[,.,
1968, 1969 .. 1970, 1971[ ., 1972, 1973, 1974[ . 1975, 1976, |

| Record no. 22 of \ 5563 filtered records

1| 1900 of 495m

T

("]

Selecting this option will copy all selected rows into the clipboard. When the copy of the selected

records into the clipboard is complete, a confirmation message such as this will appear:

xport done

\il) 8 rows have been copied in clipboard
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3.2. Save selection (*.csv file)...
(=1
Dataset | Edit Data Yiew Tools Help
Copy selection h | Ii s | H.aw® | @
production - Quantity (1970 - 2008) I .| Global aquaculture prqdu;tlon by quantity and value - PI’QdUCtIOn (wsu 2009) 23 =00
Country (Country) | Species (ASFIS spe... | Aquaculture area (F... _I 1950 I 1951 I 1952 I 1953 | 1954 [ 1955 I 1956 | |
Albania Common carp Europe - Inland wat... —'
Albania Common carp Europe - Inland wat... ]
Albania Crucian carp Europe - Inland wat... ]
Albania Crucian carp Europe - Inland wat. .. ]
Albania Freshwater fishes nei  Europe - Inland wat. ..
Albania Freshwater fishes nei  Europe - Inland wat... ]
Albania Gilthead seabream Mediterranean and ...
Albania Gilthead seabream Mediterranean and ... 1
Albania Grass carp{=White ... Europe - Inland wat...
Albania Grass carp{=White ... Europe - Inland wat... ]
Albania Kuruma prawn Mediterranean and ...
Albania Kuruma prawn Mediterranean and ... ]
Albania Mediterranean mussel ~ Mediterranean and ...
Albania Mediterranean mussel  Mediterranean and ... ]
Albanla Mullets nei Europe - Inland wat
f
Albanla Wuchang bream Europe - Inland wat... 1
Algeria Caramote prawn Mediterranean and ... 4
Algeria Caramote prawn Mediterranean and ... ]
Algeria Common sole Mediterranean and ...
Algeria Common sole Mediterranean and ... 1
Algeria Cyprinids nei Africa - Inland waters ]
Algeria Cyprinids nei Aftica - Inland waters ]
Algeria European eel Africa - Inland waters
Algeria European eel Africa - Inland waters ]
Algeria European seabass Mediterranean and ... ]
Algeria European seabass Mediterranean and ... ]
Algeria Freshwater fishes nei  Africa - Inland waters 1
Algeria Freshwater fishes nei  Africa - Inland waters ¥ b
«| » «| | »
Measures =0
-~
1950 1951 1952[ 1953[7 1954 1955[7 1956[. 1957[ 1958 j
1959',_, 1960],‘, 1961[,“ 1962|“, 1963',,, 1964',‘, 1965[,_' 1966|“, 1967',,,
1968 | 1969, 19701 . 1971, 1972 ., 1973 ] . 1974{ 1975 .., 1976 . ;I

I Record no, 22 of

| 5568 filkered records

|

205M of 495M  |[[

Selecting this option will save all selected rows into a *.csv file. A 'Save as' pop-up will appear so

that all selected rows may be saved into a *.csv file onto the hard drive where desired
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Save in: IB Temp3 3 & s A B

2

Version 3.03.2
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k_ %]AIbaniaE'xtractionl JCsY

My Recent
Documents

-
> y
‘@'

Desktop

o

My Documents

-
My Computer

@

My Network: File name:

IAIbaniaE wtractiond] csv ;I
Places ] 5

Save as type: |*. csy LI

l Save I
Cancel I

%

When the save of the selected records into a *.csv file is complete, a confirmation message such as

this will appear:

x
i) 8 rows have been saved

]

The settings for exporting CSV files can be changed in the Preferences -> Data Export (explained in

this manual in chapter 6.2).
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4. Data Menu
4.1. Filter...

Version 3.03.2
Nov 2017

The timeseries filter becomes enabled once a dataset is open. Filter can be accessed from the Data

Menu

P

#< Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
Dataset Edit | Data | View Tools

@ %% Fiter. F4 P

& Global capt A - e hg &
i Global cap g_r1 Compose a dataset filker ]:]
Country (Coun Top M hg area (F = 97 1993

And from the toolbar by opening the filter icon:

#< Fishstat) - FAO Global Fishery and Aquaculture Production Statistics
Dataset Edit Data View Tools

IO AL IR EY

il Gl':'h1 Compose a dataset filter (F4) ]':195':' - 2015) &
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Selecting Filter, will present the time series filter:

"¢ Time series filtering | = '@
Time series filtering
Select the requested items for each dimension
Country | Species | Fishing area | Measure
Include Exclude
= = (A.]
I | ]| | [pighoristan -
Albania
[ @ ] [ B:-> ] Algeria ‘=‘
American 5amoa b
Andorra
Angola
- - Anguilla
[Countrles by continent v] Antigua and Barbuda
< Africa = | Argentina
< Americas = |Armenia
< Antarctica =
<  Asia ~ | Austria
Azerbaijan
= Europt_a = Bahamas
< Oceania > | Bahrain
Bangladesh
Barbados
Belarus
Belgium
Belize
Benin
Bermuda
Bhutan
Bolivia (Plurinat.State)
Bonaire/S.Eustatius/Saba
Bosnia and Herzeaovina i
Selection mode preferences
[ QK ] [ Cancel ]

On the left side are references included (data is shown), on the left side the references excluded (no
data is shown). By default the Include side is empty; which means all references are shown.

References available for filtering depend on the dimensions of the dataset loaded. In the example
above, available filters are Country, Species and Fishing area. In this example only data for
Australia is selected.

Clicking OK will refresh the data display and activate the filter.

The arrow buttons copy the selected reference object(s) from left-to-right or from right-to-left;
according to the direction of the buttons:

s ] [ & ]

s J L» |
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When using right-click; quick selections are possible:

e Selectall
e Deselect all
e Invert selection

Albania
Algeria
Arnerica
Anderra
Angola

Anguilla
Antigua
Argenti

Exclude

Select all

Deselect all

Invert Selection

Choose attribute
Details on Afghanistan

- 9 34
2 5 4F E
12 11F 10

201 175 F 150

2

3 1502 code
FAO 12 characters code

Armenia
Aruba
Austria
Azerbaijan
Bahamas
Bahrain
Bangladesh

_——l o

Official name
Internal identifier
1503 code

UM code

Mame

Version 3.03.2
Nov 2017

e Choose attribute allows to select the attribute used for the Filter dialog. This setting is
remembered by FishStatJ.

e Details on shows details on the selected reference object

(en)

&
Afghanistan
Attribute Value
1502 code AF
FAOQ 12 characters Afghanistan
> Official name
Internal identifier 2
1503 code AFG
UM code 004
a Mame

Afghanistan
Afghanistan
Afganistan

Description

1502 code

FAD 12 characters code
Official name

Internal identifier

1503 code

UM code

Mame

Page 29 of 68



FishStatJ Manual

Version 3.03.2
Nov 2017

4.2. Aggregate

Aggregate is available once a dataset is open. It can be accessed from the Data meu:

#+ Fishstat) - FAQ Global Fishery and Aquaculture Production Statistics
Dataset Edit | Data | View Tools

1 1R AN Filter... TR = P

{4, Global capt Aggregate F5 15) &2
Country (Coun [ Change level of aggregation. Each dimension can be detailed, grouped or aggregated llﬂﬂl
Afghanistan Advancedsort.. P/ Llnlandy—0F 1200F 1200F 1000F 800F 900F
Albania Angelsharks, sand...  Mediterranear !0 A 30 30 16 79
Albania Atlantic bluefin tu...  Mediterranear - - - - - -

Or from the aggregate icon in the dataset toolbar:

¥4 Fishstatl - FAQ Global Fishery and Aquaculture Production Statistics
Dataset Edit Data View Tools

ﬁlmerE&EI.MI“.ﬁ

i Gln:ul;:lal canture nroductinn - Cuantibe (1950 - 20151 52 ]
Change level of aggregation. Each dimension can be detailed, grouped or aggregated (F5)

Country (Co -
|
: Afghanistan Freshwater fiches ...  Azia - Inland 1..'—| WF 1200F 1200F 1000F  BOOF  90C

Selecting this option will present the Time series aggregation popup shown here:

-

_'?, Time series aggregation @

Time series aggregation

Select the level of aggregation for each dimensicn

Country Grouped
Aggregated

Species Grouped
Aggregated

Fishing area Grouped
Aggregated

[ oK ] [ Cancel

Aggregation setting are memorized for each dataset by FishStatJ.
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On the Time series aggregation popup, aggregation selections deepened on the dimensions of the
dataset.

When selecting Grouped, it is possible to select the grouping (including Handpicked aka custom
grouping).

Detailed [ Handpicked
Country (Grouped VY
Aggregated Continent -

As an example, grouping a data element Continent (within Country); while aggregating Species and
Fishing area, produces the following result:

- =

& Fishstat) - FAOQ Global Fishery and Aquaculture Production Statistics EI@
Dataset Edit Data View Tools
@8l BENE Oz B4 e
{1l Global capture production - Quantity (1950 - 2015) % Q |'_| “,, = O
Country (Continent) Species (ASFIS spe.. 19 2010 2011 2012 2013 2014 20
| Africa All ? 2138... 2386.. 2579.. 3310.. 3512, 181!
Africa All Lo F78G,. 7793.. 8446, 8395, B654.. 880
Americas All hooo 1314, 1254, 1276.. 1733.. 1584, 99X
Americas All .. 1800.. 2298. 1832.. 1936.. 1738.. 17%
Asia All h..o 5672, B6272.. 6927.. 8729.. 1031.. 183
Aczia All L. 4771.. 4759.. 4858, 4898, 5096.. 511!
Europe All .. 1262.. 1963.. 1225.. 2347.. 1845.. 713
Europe All Lo 1411, 1381.. 1326, 1378, 1402.. 143
Oceania All j.. 0434, 4970.. 6743, 5609, 5329.. 356
Oceania All L. 1215, 1178, 1275.. 1209, 1331.. 13§
Others All - - - - - -
Others All Y. 1891.. 1868.. 1098.. 2103.. 3782 387:
] i [ m.| »
Measures = 8
1950 1951 1952 1953 1954 :_
12 filtered records : 123M of B48M ‘@‘
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4.3. Top/Other...

[@] Fishstat -0l x|
Dataset Edit | Data Yiew Tools Help
e ANCERE-ES S
et — =
[ 1. Global oy pumre— rcwso-zooezs 411/ Giobal production - Quankity (1950 - 2009) 22 =
| _Country {Cour Advanced sort. .. 1950 1951 ] 1952 I 1954 ] ﬁu

Afghanistan Freshwater— 100 100 100 100

Albania Angelshark

Albania Atlantic boi

Albania Bighead ca - - - -

albania Bleak

albania Blue and re

Albania Blue whitin
. Albania Bluefish

albania Caramote |

Albania Catsharks,

Albania Chub - - - -

albania Common cé

albania Common cL

Albania Common de

Albania Common o¢

Common sc Y. ¥
- > [

(@ Measures =la

1950 1951]_,_ 1952|,,_ 1953|,,, 19541 1955],_, :J

1956],_, 1951|,,, 1958]_,, 1959',,, 1960[,_, 1961],,,

1962 1963 1964 1965] 1966 [ 1967

1968| 1969' 1970' g 1971 I = 1972' = 1973| -

1974 - 1915| = 1976 - 1917| Z 1978| E 1919| 5

1980[ = 19381 | 1982] 1983| 559 1984] 392 1985] 406

1986| 499 1981] 564 1988 | 724 1989| 583 1990| 754 1991 | 283

1992] 196 1993| 150 F 1994| 100 F 1995| 52 1996| 104 1991| 65

1998| 220 1999| 220 2000 | 220 2001 | 120 2002| 150 2003| 84

2004] 76 2005 | 68 2006] 86 2007' 132 2008| 132 2009] 154 _J

v

|| 4ssmorgoom |

| Record no. 8 of | 21023 filtered records

Selecting this submenu item presents the Top/Other selection popup window
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EA Top/Other selection g X|

Top/Other selection

Select top records and groups everything else as "Other"

Dataset: Global production

by field | 1950

Ll k<

by measure I Quantity (number)

& allrecords

" Top records
(" Records comptrising percent of total
" Yalues and greater

EA Top/0Other selection

Top/Other selection

Select top records and groups everything else as "Other"

Dataset: Global production

by field l 1950 ‘:I
by measure l Quantity (number) LI
[

" allrecords

& Top l 15 records

(" Records comprising percent of total

" Values and greater

| QK I Cancel

Produces the result shown on the next page
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=lofx|

Dataset Edit Data Yiew Tools Help

@] %Azlléﬁﬁoml@zlﬁm”gjm

A]_i& Global capture production - Quantity (1950 - 2009) | 1

Country (Countr Species (ASFIS spe... | Pro

Canada Harp seal Atl: 181377 321581 177071 158966 136720
MNorway Fin whale Ant 11204 9723 10364 9422 1270
MNorway Harp seal Atl: 59737 85144 64154 46340 40764
MNorway Harp seal Atl: 101705 134004 130037 113920 127696
Morway Hooded seal Atle 67693 83380 39962 26024 66001
South Africa Toothed whales nei Mai 2602 2773 2452 1677 1023
Un. Sov, Soc, Rep. Caspian seal For 88236 86599 64833 45333 23800
Un. Sov. Soc. Rep. Common dolphin Me: 40196 19136 47837 40407 78255
Un. Sov. Soc. Rep. Harp seal Atl: 194768 192493 131600 85638 152200
Un. Sov. Soc. Rep. Morthern fur seal Pac 12365 3211 6757 6531 3304
Un. Sov. Soc. Rep. Ribbon seal Pac 4091 3050 2385 325 2406
Un. Sov. Soc., Rep. Ringed seal Pac 286038 34132 38630 30098 35878
Un. Sov. Soc. Rep. Walrus Pac 4030 4912 3542 2725 4995
United Kingdom Fin whale Ant 3945 3098 3914 3975 5601
United States of Am... Morthern fur seal Pac 60204 60689 63870 66669 63882
Others Others Otk 35775 60957 45734 45041 79978

4[ | »! 4! l =>=!!
@ Measure\ =

1950' 1951' 1952' 1953' 1954| 1955| A
1956' 1957' 1953' 1959' 1960' 1961'
1962' 1963] 1964' 1965' 1966' 1967'
1968' 1969' 1970' 1971 I 1972' 1973|
1974’ 1975| 1976' 1977' 1978' 1979|
1980' 1981' 1982' 1933' 1934' 1985]
1986' 1987' 1983' 1939' 1990' 1991|
1992' 1993' 1994' 1995' 1996' 1997'
1998 l 1999 l 2000 I 2001 I 2002 I 2003 l
2004' 2005 | 2006 l 2007 l 2008 I 2009 I
=
16 filtered records ” 30+M of 990M l@
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4.4. Advanced sort...

Dataset Edit | Data Yiew Tools Help

| @] % ¢ A ful@s|aaxm|o

s~ Adagregate —
Al Globalcal  topjother... p (1950 - 2009 | i Global eradhiction - Quanty, (195052009 &t

|_Country (Cou 1950 1951 1952 | 1953 | 1954 |

. Afghanistan 100 100 100 100 100
Albania Angelshark . . . . .

. Albania Atlantic boi

. Albania Bighead ca - - - - -

- Albania Bleak
Albania Blue and re

- Albania Blue whitin

. Albania Bluefish

. Albania Caramote |

. Albania Catsharks,

- Albania Chub - - - - -

. Albania Common cé
Albania Common cL

. Albania Common de
Albania Common ot ’
Albania Common s ¥

(@ Measures = EW
1950|,,, 1951'_,_ 1952|,,_ 1953',_, 1954],,, 1955'_,, —AJ
1956',,, 1957],,, 1958],,, 1959',,, 1960',,, 1961],,,

1962',,, 1963]_,, 1964',,_ 1965'_,, 1966],,, 1967],_,

1968' 1969| 1970' = 1971 l = 1972| 2 1973' -

1974| < 1975| - 1976' & 1977| 2 1978[ < 1919' -

1980' = 1981| 1982] 1983' 559 1984' 392 1985] 406

1986] 499 1981] 564 1988' 724 1989| 583 1990| 754 1991 I 283

1992| 196 1993| 150 F 1994| 100 F 1995| 52 1996| 104 1991| 65

1998| 220 1999| 220 2000 | 220 2001 | 120 2002[ 150 2003] a4

2004[ 76 2005 | 68 2006] 86 2007' 132 2008| 132 2009| 154 _ﬂ
| Record no. & of ’ 21023 filtered records | | 486M 4F 990M l[ﬁ]

Selecting this submenu item presents the Advanced sort popup window where the dataset key
elements may be included within the sort or excluded from the sort. Additionally, the sort ordering
(i.e. ascending or descending) may be selected for each key dataset element
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x|

[V active

IV Active

IV Aactive

IV active

[~ Active

Dimension/Period Concept Attribute Direction
| Country | |country =] lName x|l ®2 ©
Dimension/Period Concept Attribute Direction
|Species ~| IASFIS species =] IName ¥l @z ©
Dimension/Period Concept Attribute Direction
|Production area ;j lOmajor fishing area Ll IName ¥ & 2l ©
Dimension/Period Concept Attribute Direction
| Measure ~| lMeasure | |Mame 7l &2 ©
| | 5 | B ®4l e

| QK I Restore defaults I Cancel

For example, sorting the Species element with a descending order produces the following result:

Advanced sort

Choose the advanced sort criteria.

x

[V active

IV active

IV active

IV active

[ Active

Dimension/Period Concept Attribute Direction
ICountry =] lCountry | IName x|l ©2 ©
Dimension/Period Concept Attribute Direction
|Species :I |ASFIS species _V_l IName _v_| Cal ©
Dimension/Period Concept Attribute Direction

l Production area

Dimension/Period

LI lOmajor fishing area Ll IName

Concept

Attribute

H 2l COf

Direction

I Measure

;I l Measure

3 | MName

ezl X%

H |

o |

| oK I Restore defaults I Cancel

Hl #2l €%

Produces the result shown on the next page
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=lofx|

Dataset Edit Data Yiew Tools Help

@ % S%as | EoEme=|3.a%8 |0

e
A, Global capture production - Quantity (1950 - 2009) . Globa

Country (Country) | Species (ASFIS spe... | 1950
: Afghanistan Freshwater fishes nei = 100 100 100 100
Albania \Wuchang bream St St
Albania Wreckfish
Albania Turbot
Albania Swordfish
Albania Surmullets{=Red m...
Albania Striped venus
Albania Stony sea urchin
Albania Smooth-hounds nei
Albania Smooth hammerhead
Albania Silversides{=Sand s...
Albania Silver scabbardfish
Albania Silver carp
Albania Shi drum
Albania Shads nei
Albania Scorpionfishes nei

Albania Scomber mackerels nei " " " " -
Al amis S mvdimin mmv =l
4 4 4 >

/ Measure\ S H)
1950' 1951' 1952' 1953' 1954’ 1955| A
1956' 1957' 1953' 1959' 1960' 1961'

1962 I 1963 l 1964' 1965 I 1966 l 1967 l
19638 | 1969 I 1970 I 1971 I 1972 ' 1973 |
1974| 1975 l 1976 I 1977 I 1978 l 1979 l
1980' 1981' 1982' 1983' 1934' 1985'
1986 I 1987 l 1988 | 1989 I 1990 I 1991 l
1992 l 1993 I 1994' 1995 I 1996 | 1997 I
1998 I 1999 l 2000 I 2001 I 2002 l 2003 I
2004' 2005 I 2006 I 2007 l 2008 I 2009 I
ba
21023 filkered records J | 519M °|[ 990M l@
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5. View Menu
5.1. Columns...

&+ Fishstat) - FAO Global Fishery and Aquaculture Commuodities Statistics
Dataset Edit Data Tools

ﬁ | iz 'E; "A % Columns... F6

1, Global cormmoditie Calculated columns... Ctrl+Fo ] e
Country (Country) | | Show details Ctl:D | 1989
Afghanistan Grand totals Ctrl+T

Albania Show metadata...

Albania —

Albania Alaska poll

Selecting this option will allow the user to change the columns (attributes) that are displayed of the
dataset. When the option is selected, the Preferences popup window is displayed as shown here:
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4 Preferences | = @
Dirmensions Dimensions
Pericds
Choose visible dimension attributes
+ Dimensions
Country | Commodity | Trade flow
Dimension: Country
Concept Mame Description
Country Marne Mame Edit...

LR

Remowve...

’Flestore Defaults] [ Apply ]

| ok || cance |

Note: For species, when the common name is not available, the scientific name will be shown
instead.

The Dimensions used for the data display can be changed by selecting Concept:
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L2 [
Dimension column settings
Concept H
Attribute Contlnent
Economic class
Economic group
Economic region (for trade statistics)
Alternate attribute Gecgraphical region
[] Use an alternate attribute
Alternate attribute FAQ 12 characters code
| ok || cancel
The Attribute can be chosen:
L2 [
Dimension column settings
Concept Country -
Attribute m H
FAQ 12 characters code
1502 code
1503 code

Alternate attribute
[] Use an alternate attribute

Alternate attribute

Internal identifier

Official name
UM code

| ok || cance |

Version 3.03.2
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Example: for the Concept Species, the common name used for display can be replaced with the

Scientific name.

The Periods displayed may be changed as shown here:
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e

E Preferences
Dimensions
| Periods |

Periods

RN (O ==

Choose visible chservation periods

+ Periods

Period

1978
1877
1978
1979
15980
1981
1982
19a3
1934
1985
1985
19&7
1988
19a9

EEEEEEEEEEEEEE

m

-

[ Al [[ None

l ’ Check selection ] ’Unch eck selection

| ok || cancel
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5.2. Calculated columns...

4 Fishstat) - FAOQ Global Fishery and Aquaculture Commodities Statistics
Dataset Edit Data Tools

ﬁ| k- %} '*A 24 Columns... F&
1% Global commaoditie Calculated columns... Ctrl+Fa |

Country (Country) v 1989 1

' — {+D
. S] Manage calculated columns [
Afghanistan Grand totals Cirl+T
Albania Show metadata...
Albania S
Albania Alaska poll

Selecting this option will allow the user to create calculated columns that are built from the original
dataset columns. When the option is selected, the Preferences popup window where the user can
create or edit calculated columns is displayed as shown here:

=4 Preferences = @
Calculated columns Calculated columns
Manage calculated columns properties
Calculated columns
Function Description New...
Edit...
Remove...
4 L1 b
[Restore Defaults-J l Apply ‘
[ oK ] [ Cancel J

Calculated columns may be created (New...) or edited (Edit...) that produce the Calculated
columns definition popup
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s

Calculated columns definition

Define a new calculated column

Column name Arithmetic mean

o ==

Function Arthmetic mean

Computes the arithretic mean of the set of values, Uses the
definitional formula: mean = sum_i) / n where n is the number of
ocbservations.

Parameters
Skipping parameters Function pararmeters
Skip unknown values () Yes @ Mo
Skip estimated values (0 Yes @ Mo

Skip negligible values () Yes @ Mo

Skip zero values 1 ¥es @ Mo

Ok ] ’ Cancel

Many statistical functions are available for calculated columns as shown here:
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s

-

Calculated columns definition

Define a new calculated column

Column name

Function

Parameters

Skip zero values

Skipping paramett p o eccion prediction
Skip unknown vall Regression slope

Skip estimated wval

skip negligible valt Regression slope standard error

Arithmetic mean

‘Arithmetic rmean v'

Geometric mean

Harmenic mean

Max

Median

Min

Percentile

Regression Pearson's product moment correlation coefficient
Regression coefficient of determination
Regression intercept

Regression intercept standard error estimate
Regression mean square error

Regression slope confidence interval
Regression slope correlation significance

Root mean square
Second central moment
Skewness

Standard deviation

Sum

Third central moment
WYariance

| ok || cance

Version 3.03.2
Nov 2017

When a calculated column is created, it is shown at the end of the time-series as shown here:
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[®] Fishstat L =10l x|
Dataset Edit Data View Tools Help
@ ¢ Sas EaEWM[es | 3.a%8 |0
e — ~
A Global capture production - Quantity (1950 - 2009) f il | prod =
Country {Country) l Species (ASFIS s « - Arithmetic mean | «
Afghanistan Freshwater fishe= 100 100 100 100 — 669,17 —
albania ‘\Wuchang bream 1.73
Albania Wreckfish 0.3
Albania Turbot 0.7
Albania Swordfish 217
Albania Surmullets{=Red 67.57
Albania Striped venus 29.73
albania Stony sea urchin 1.27
Albania Smooth-hounds r 3.78
Albania Smooth hammert 0.25
albania Silversides{=5an 11.43
Albania Silver scabbardfi: 1.57
Albania Silver carp 147.87
albania Shi drum 0.98
Albania Shads nei 8.57
Albania Scorpionfishes ne 0.07
Albania Scomber mackere 7.75
albania Sardinia coral 0.26
Albania Salmonoids nei 15.83
Albania Salema 0.63
albania Round sardinella 2.27
Albania Rocklings nei - - - - 0.62
Albania Roaches nei 12.35
albania Rays, stingrays, 42.03
Albania Rainbow trout 64,38
Albania Porgies, seabrea v ¥ 1638 «
<| » « | 4 |»
4 %y
Measures =m
1950 | 1951 1952 1953 1954/ 1955 1956 | ;I
1957' 1958' 1959' 1960' 1961' 1962' 1963'
1964' 1965' 1966' 1961' 1968' 1969' 1970'
1971 | 1972 1973 | 1974| 1915[ 1976 | 1977 |
1978' 1979' 1980' 1981' 1982' 1983' 1984'
1985' 1986' 1987' 1988' 1989' 1990' 1991'
1992] 1993' 1994' 1995' 1996' 1997' 1998'
1999' 2000[ 2001[ 2002' 2003[ 2004' 2005'
2006 | 2007 | 2008 | 2009 | Ll
21023 filtered records || 4osmof gagm |
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5.3. Show details

E

%4 Fishstatl - FAQ Global Fishery and Aquaculture Commaodities Statistics EI@
Dataset Edit Data View Tools

B %Al EAEE= | Bae

. Global commeodities production and trade - Quantity (1976 - 2015) 2 ﬁ “,, = B8

Country (Country) = 1986 1987 1988 1989 1990 1991 1992 1993 1994 1995 it
Afghanistan

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania
Albania - -
Fi Il 2 Fi ] 3

Row Details = 0

1976 1977 19738 1979 1980 1981
1982 1983 1984 1985 1986 1987
1988 1989 1990 1991 1992 1993
1994 1995 1996 1997 19498 1999

91751 filtered records | Unit: t | 755Mef128aM I

Selecting or deselecting this option will turn on or off the detailed information that is displayed at
the bottom of the FishStatJ main display. This option allows more or less records of the time-series
to be displayed. In the image above, the details are turned on where Measures are presented.

Deselecting this option will remove the 'details' shown at the bottom of the FishStatJ main display.
In this image, the details are not displayed:
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4 Fishstat - FAQ Global Fishery and Aquaculture Commaodities Statistics =R ==
Dataset Edit Data WView Tools
B Y%A BEME | B
{4, Glebal commodities production and trade - Quantity (1976 - 2015) 23 O = O

Country (Country) = 1986 1987 1988 1989 19490
! Afghanistan

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania

Albania -
« [ 3 Fl - ]

1891

91751 filtered records | Unit: t

19842 1993 1994 19845 il

5F
2F

60 F

760M of 1289M [T
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I

Country (Country)

Afghanistan
Albania
Albania
Albania
Albania
Albania
Albania
Albania
Albania
Albania
Albania
Albania
Albania
Albania
Albania
Albania
Albania

4 il

® Grand totals &3

1976 41203208
1982 52285900
1988 50447076
1394 84283176

Columns...

Fo

Calculated columns... Ctrl+Fa

Show details
¥ Grand totals

Show metadata...

Ctrl+D
Ctrl+T

4 Fishstatl - FAQ Global Fishery and Agquaculture Commodities Statistics
Dataset Edit Data Tools
1 IRV R

(% Global commaoditie

) 52
1990

1977
1983
1989
1995

41388637
52287002
71610784
83753813

1973
1954
1990
1996

I

44227282 1979
56687181 1985
71297229 1991
85020531 1997

91751 filtered records

46919557
60339524
71682019
26679356

1891

1980
1986
1992
1993

Unit: t

9 “'!! - E

1942 1943 1994 19845 il

= 0O

47724171 1981 49093572
64135476 1987 §5571230
70813333 1993 75545092
82731000 1999 38743314

8s7M of 1289M [T

Activating Grand-totals will create one (or two, depending on dataset) additional tabs in the
FishStatJ display that show grand totals for the time-series.

One tab will be for Quantity (tonnes) as shown here:
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e

#4 Fishstatl - FAOQ Global Fishery and Aquaculture Production Statistics
Dataset Edit Data View Tools
BT %A EHE|EE) E S

. Global capture production - Quantity (1950 - 2015 &3

Country (Country) Species (ASFISspe.. = 11 2002 2002 2004 2005 2006 2007 2008 2008 2010

Afghanistan Freshwater fishes ... JF 900F 900F 1000F 1000F 1000F 1000F 1000F 1000F 1000F
Albania Angelsharks, sand... j 7 1 4 68 55 12 23 14 78
Albania Atlantic bluefin tu... - - - - - - - - 50 -
Albania Atlantic bonito ] 24 4 2 23 30 19 27 21 23
Albania Barracudas nei 2 4 7 7
Albania Bighead carp - - - - - - 24 24 5
Albania Bleak ; 234 2ZB0F 330 457 402 504 180 530 505
Albania Blue and red shrimp - 34 22 15 12 13
Albania Blue whiting(=Po... - 6 1 5 8 - - - -
Albania Bluefish : 2 6 9 - - - -
Albania Bogue ] 150 84 76 68 86 132 132 154 &0
Albania Caramote prawn } 84 178 285 150 102 18 23 20 228
Albania Catsharks, nurseh... . 1 2 4
Albania Common carp ] 260 350F 415 540 430 435 an 214 335F
Albania Common cuttlefish ! 52 43 70 75 86 47 b2 126 98
Albania Common dace - - - - - - 8 8 4
Albania Commen dentex } a0 4 5 25 40 27 32 43 25
Albania Commeon dalghin.., .
Albania Commen octopus | 105 137 135 47 82 82 g2 109 47
Albania Commen sole | 195 38 73 40 48 63 63 64 120
Albania Common spiny lo.. L 2 1 2 2 1 4 3 1
Albania Comrmon squids ... i 85 45 13 64 102 a 107 a0 64
Albania Croakers, drums nei I 8 1 13 2 15 2 2 & 1
Albania Crucian carp j 260 300F 350 381 394 431 380 208 235F
Albania Deep-water rose s... . 57 1 8 78 65 198 187 262 7
Albania Dogfish sharks nei il ] 7 1 7 56 73 30 36 45 £
P - - . . - - - 4 4 4 an - - -

Row Details | £ Global capture production - Quantity (number) | £ Global capture preduction - Quantity (tonnes) &2

1950 192458069 1951 216966727 1952 2357310 1953 24078236 1954 25089307.14 1955 27512275 1956 9178593
1959 37306833 1960 34700181 1961 3330192 1962 42035679 1963 420063711 1964 475868271 1965 486536134

For example, Global cature produciotn has two Gand total tabs for Quantity (number) and
Quantity (tonnes) as shown here.
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5.5. Show metadata...

¥4 Fishstatl - FAQ Global Fishery and Aquaculture Production Statistics
Dataset Edit Data | View | Tools

ﬁ | iz % "A %l Columns... F6
{i, Global capture pro Calculated columns... Ctrl+Fo
I::I:Il.lr'ltf'_'," (Cl:ll.lﬂtr}":] \"Ir Show details Ctrl+D ki 2004 :
Afghanistan \"F Grand tDtElS Ctr|+T F 1':":":] F 1':
Albania Show metadata... 4
Albania -
Albania Atlantic bonito [ Show dataset and time series metadata ]
Albania Barracudas nei . 2

Selecting this option will display the metadata about the time-series that is selected within
FishStatJ. The metadata icon from the toolbar can also be used:

Dataset Edit Data View Tools

@ 7 %A s Ewamlz:—.ﬂ

|\, Total population - Number (1961 - 2013) =2

[ Show dataset and time series metadata ],
Country (Country) Measure (Measure) ~ 1’ 1982 1983 1984 1985 198

An example of the metadata presented is:

I

« Metadata
Metadata

Global capture production - Quantity (1950 - 2014)

Metadata | Dimensions | Attachments | time series
Global capture production

Country | Species | Fishing area | Measure
Dimension

Name Fishing area Acronym AREA
Description Fishing area

Reference concept
Name FAQ rnajor fishing area Acronym AREA
Description FAOQ major fishing area. For statistical purposes, 27 major fishing areas have been internationally established to date,

These comprise 8 major inland fishing areas covering the inland waters of the continents and 19 major marine fishing
areas covering the waters of the Atlantic, Indian, Pacific and Southern Oceans, with their adjacent seas.
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5.6. Dataset citation/map/notes

The three icons, in the order from left to right, do open:
e Dataset citation (citation icon)
e Dataset map (map icon)
e Dataset notes (notes icon)

These icon are only shown; if the citation/map/notes have been defined for the dataset.

An example of the dataset notes dialog:

= ==
Global aquaculture production - General notes

Glebal aguaculture preduction - General notes

GLOBAL AQUACULTURE PRODUCTION

The annual series of aquaculture production begin in 1950 for the quantities and in 1984 for the values. Aquaculture is the
farming of aquatic organisms including fish, molluscs, crustaceans and aquatic plants. Farming implies some form of
intervention in the rearing process to enhance production, such as regular stocking, feeding, protection from predators, etc.
Farming also implies individual or corporate ownership of the stock being cultivated. For statistical purposes. aquatic organisms
which are harvested by an individual or corporate body which has owned them throughout their rearing period contribute to
aquaculture while aquatic organisms which are exploitable by the public as a common properiy resource, with or without
appropriate licenses, are the harvest of fishenies. Production of fish, crustaceans and molluscs 1s expressed in live weight, that 1s
the nominal weight of the aquatic organisms at the time of capture. The harvest of aquatic plants 1s given in wet weight.
Quantities are given in tonnes. The value of aguaculture, converted from local currencies, is reported in 1000 US dollars using

m

appropriate exchange rates.

Fish, crustaceans, molluscs and all other aquatic organisms included in the database have been classified according to
approximately 589 commercial species items, further arranged within the 30 groups of species constituting the nine divisions of
the FAO International Standard Statistical Classification of Aquatic Animals and Plants (ISSCAAP). Starting with the March
2002 release, data included in this dataset reflect a revision of the [ISSCAAP groups. This revision affected names and species
attribution of groups 33, 34 and 37 of the Marine Fishes division. The taxonomic code descriptors are taken from the " ASFIS list
of species for fishery statistics purposes”.

Several countries still report their aquaculture production by large groups of species. In these circumstances the data presented by
individual species items are likely to be underestimated. Therefore, when examining the statistics for a particular species, it
should be noted that an unknown proportion of the production for that species might have been reported by the national office
under the generic, family or order name of the species, or even more roughly as 'fishes not identified’. Consequently, species item

tnfa]q 'R'Pﬂ'l'lPﬂT']\.—' 'I'Iﬂl'1P"F‘QﬁI‘T'IaT'F' f]"IF' fF‘ﬂ] nrr\rhwﬁnn F\F'H"IF‘- 1‘1‘11"11"1'1‘(111?!1 EﬂF‘F‘{PI’-‘. S
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6. Tools Menu

I

=+ FishStat)
Dataset Edit Data View
il '% | Custom groups Ctrl+G
Preferences Ctrl+P
Help - Manual
Key Assist Ctrl+5Shift+L
About Fish5tatl

6.1. Custom groups

Note: The Custom groups menu is only available when a dataset is open.

P =

.= Custom groups manager =

Custom groups

Create, edit or delete custom groups used for filkering and/or aggregation

Country | Measure

Africa South of S5ahara

Commonwealth of Independent States

European Union [28]

US5R. Former Area of

Latin America and the Caribbean

OECD - Organization for Economic Co-operation and Der
Group of 77

ASEAN - Association of 5Southeast Aszian Hations
WAEMU - West African Economic and Monetary Union

%

2

m
|| %
O I

QK l ’ Cancel
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Custom groups are pre-defined for some time-series elements. The above screen shows the custom
groups for Country while the image below shows custom groups that already defined for Species

P Y

.=u Custom groups manager @
Custom groups
Create, edit or delete custom groups used for filkering and/or aggregation
Country | Species | Fishing area | Measure
Fizh, crustaceansz, molluscs_etc. | ’ aam New... ]
Aquaculture species
Capture species [ #- Delete... ]
[ /7 Edit |
[ =| Copy... ]
OK l ’ Cancel

When a new custom group is to be created with the New... button, the New custom group
definition popup is presented.
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¥4 New custom group definition \E\
Include Exclude
[ A. A.
L€ ] LB Aba »
Abalones nei
Whenh no selection is Abu mullet
made all items will be [ « l [ b Acoupa weakfish
included Adriatic sturgeon
Aesop shrimp
- — Africa-bighead catfish, hybrid
’Sper_les by ISSCAAP division ] African bonytongue
< Aqguatic plants = | African bullhead
< Crustaceans = | African catfich
< Diadromous fishes = | African forktail snapper
< Freshwater fishes = ;:\:r!can lungfishes
< Marine fishes > [f¥mcan moonfish
- . . African obscure snakehead
= Miscellaneous aguatic animal p... = African pompano
< Miscellaneous aguatic animals > | African scraping feeder
<  Molluscs = | African sicklefish
= Whales, seals and other aguati.. = |African striped grunt
Airmara
Aka coral
Akiarni paste shrimp
Alaska plaice
Alaska nollocki=Walleve nnll} S
Selection mode preferences
Custom group name
English | French | Spanish | Arabic | Chinese | Russian
Custom group description
English | French | Spanish | Arabic | Chinese | Russian
[ OK ] [ Cancel ]

When an existing custom group requires editing with the Edit... button, the New custom group
definition popup is presented with the existing group members listed in the Include field.

A “Custom group name” and “Custom group description” can be entered in the dialog box; as a
minimum the English field should be filled.

If the data needs to be filtered — for example only a number of countries or species — then the Filter
dialog is the solution (filter settings are saved and can be changed). If the user needs to analyse
several groups of countries (or species, or catch areas) repeatedly, then custom groups are useful
because they allow selections (custom groups) to be saved and re-used.
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Austria
Belgium
Bulgaria

Lithuania
Luxembourg
Malta
Metherlands
Poland
Portugal

¥
E] Selection mode preferences

Custom group name

i
EE

FishStatJ Manual

’Countriﬁ by continent

7

< Africa
Americas

VW VW WY
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Ty

Exclude
[ A. ]
Saint-Martin -
Saint Vincent/Grenadines
Samoa

Sac Tome and Principe
Saudi Arabia

Senegal
Serbia
Serbia and Montenegro

Seychelles

Sierra Leone

Singapore

Sint Maarten

Solomon Islands
Somalia

South Africa
SouthGeorgia/Sandwich Is
South Sudan

5Sri Lanka

5t. Pierre and Miquelon
Sudan

Sudan (farmer)

Suriname

Englishl Frenchl Spanish | Arabic| Chinesel Russian|

Eurcpean Union (EU28)

Custom group description

Englishl Frenchl Spanish | Arabic| Chinesel Russian|

Eurcpean Union (EU28)

[ ok || Ccancel
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6.2. Preferences
6.2.1 Preferences - General preferences
- Preferences — @
| General preferences - L
G | pref
enerzf e Fishstatl general preferences
Data display
Data export | Save/Load timeseries settings on exit/open
Languages | Synchronize timeseries within the sarme dataset
Reports
| Restore Defaults | | Apply |
[ OK ] | Cancel |

Here, the user may specify preferences on General preferences, Data display, Data export and
Languages.
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4 Preferences

type filter text

General preferences
4 | Data display
Format highlights
Format numbers
4 Data export
.csv and clipboard
Languages
» Reports

Data display

Display the last column on time series loading

Statistical measures columns width
@ Dynarmnic width
") Fixed width

I Restore Defaults] I

Apply

I

ok ]I

Cancel
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6.2.3 Preferences — Format highlights
4 Preferences =] @
type filter text Format highlights =0 v w
General preferences
4 Data display Show unavailable value as * color
Format highlights
Format numbers Show negligible values (<0.5) as 0o * color
4 Data export N
«csv and clipboard Show repetition as 200k - color
Languages Show zeroes as - * color
» Reports
Show estimate as Z00F - color
IRestore Defaults] I Apply ‘
[ OK l I Cancel

Formatting options control how data symbols are shown (set color and symbol display); the

formatting is used for display and when exporting data.
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6.2.4 Preferences — Format numbers
&< Preferences = @
type filter text Format numbers =l b

General preferences
4 Data display
Format highlights
Format numbers
4 Data export
.csv and clipboard
Languages
» Reports

Statistical measures

l

Digits before decimals 1
Digits after decimals i
123453333 0.3333333 12345678
1234533 0.33 12345678
Calculated measures
Digits before decimals 1
Digits after decimals 2
123453333 0.3333333 12345678
1234533 0.33 12345678
— | | %
’Restore Defaults] ’ Apply
[ OK l ’ Cancel
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6.2.5 Preferences — Data export
=< Preferences = @
type filter text .csv files and clipboard =T v v
General preferences
. Data display Export preferences
4 Data export 7| Export tables headers
yCo¥ and cliphoad Split values and symbols in two columns
Languages .
- Reports =
Don't export symbols
| Export with totals on selected rows
| Export citation
Re-adjust the preferences on each export
| Restore Defaults| | Apply |
[ OK l | Cancel |

Don’t export symbols

Export citation

Export table headers: when selected, headers are exported
Split values and symbols in two columns

Export totals on all rows selected

e Re-adjust the preferences: will show the panel before each export operation to allow

different settings
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Automatically downloads the FishStat] manual and opens it; the manual is a PDF (portable

document format) file.

e Windows requires Acrobat Reader to open PDF documents
e macOS can open PDF documents using the Preview application

The manual is downloaded to the workspace folder (refer to chapter 8.4 for more details).

6.4. Key Assist

Selecting this option will display a popup listing the shortcut keys to maximize efficiency in using
FishStatJ. The popup with the key shortcuts is shown here

Activate Editor _AJ
Backward History Alt+Left

Close Chrl+w

Close All Chrl+Shift+W

Collapse all Ctrl+Shift+Numpad_Divide
Content Assist Ctrl+Space

Context Information Ctrl+Shift+Space

Copy Ctrl+C

Cut Chrl+X

Delete Delete

Dynamic Help F3

Expand all Ctrl+Shift+Numpad_Multiply
Find and Replace Ctrl+F

Forward History Alt+Right L—
Help Contents F1

Last Edit Location Ctrl+Q

Maximize Active View or Editor  Ctrl+M

Mew Ctrl+N

Mext Ctrl+.

MNext Editor Ctrl+F6

Mext Page Alt+F7

Mext Perspective Ctrl+Fa

Mext Sub-Tab Alt+PageDown

Mext View Ctrl4+F7

Paste Chrl+y

Previous Ctrl+, v
| | »
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6.5. About FishStatJ
Selecting this option will present the official FishStatJ information about version, legal use,
development team and contacts for assistance. An example is:
4 About FishStat] o |23

BT A N, TUB SRR THO O THE
BTIG WA T

Fisheries and
Aguaculture Department

Installation Details

Fish5tatl, a toel for fishery statistics analysis
Release: 3.02.0-b02
by Thomas Berger, Fabrizio Sibeni and Francesco Calderini

This product includes software developed and distributed under the EPL, LGPL and Apache
licenses.

Please also refer to the Dataset Motes (Menu | View | Show Metadata |Attachments)”

Questions and feedback should be addressed to:
FAO

Fishery and Aquaculture Department

Statistics and Information Branch

Ernail: Fish-5Statistics-Inquiries@fac.org

Visit httpe/www . fac.org/fishery/statistics/software/fishstatj/en
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7. Frequently asked guestions (FAQ)
7.1. What does that symbol mean?

FishStatJ uses the following symbols for statistical data:
Data not available; unobtainable;
Data not separately available but included in another category
- Nil or zero
0 More than zero but less than half the unit used
F FAO estimate from available sources of information

Nei means “Not elsewhere included”.

In FishStatJ, you can configure the color of the symbols in the panel:
Tools->Preferences-> Data Display->Format highlights (refer to chapter 6.2.3).

As for data and symbol export to Excel, please be informed that you can configure how data and
symbols are exported (or not exported) in

Tools->Preferences-> Data export .csv and clipboard.

“Don’t export symbols” is one of the options you can select (refer to chapter 6.2.5).

7.2. Why is the grand total in FishStatJ different from the
number published in the FAO yearbook?

Trying to cover all products derived from fisheries activities, in both inland and marine waters, the
FAOQ Fishery production datasets (capture and aquaculture), include some products which are not
(or not directly) destined to food consumption, such as marine mammals, crocodiles, corals, pearls,
mother-of-pearl, sponges and aquatic plants. Those products are excluded from the all country,
regional and world totals presented in FAO Yearbooks of Fishery Statistics as well as other FAO
publications.

When viewing time-series data in FISHSTAT, in order to obtain the same aggregates you must first
filter the dataset using a Custom Group:

1. Open the Filter Dialog Box (Data->Filter or F4)

2. Click the <Species> tab

3. Click the Groups combo box and select <Custom Group>

4. Click <Fish, crustaceans, molluscs, etc.>

5. Click the single left arrow in order to move under the “Include™ left panel all selected species
belonging to <Fish, crustaceans, molluscs, etc. (see picture below)

6. Click <OK>. The program will return you to the Main Window.

The aggregation grouping for capture and aquaculture datasets is mentioned in the dataset notes
where applicable. Access to dataset notes is explained in chapter 5.6.
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7.3. How to export data?
You can EXPORT data from FishStatJ in two different ways:
e You can simply copy a selection of rows and paste it on an Excel file (with the right button
menu or with the Ctrl+C shortcut).
e Oryoucan
e The second way will allow you to choose between few export options. You can configure

how data and symbols are exported (or not exported) in Tools->Preferences-> Data export
.csv and clipboard

7.4. How often is the data/application updated?

We publish new data as soon as we receive the complete set from member countries and have
completed our verification. Usually, datasets are updated once per year. The release time for Global
Capture and Aquaculture Production is in the second quarter every year.

New or updated Datasets will automatically show in the Browse workspace menu; refer to chapter
2.1 for a detailed explanation.

When the FishStatJ application is launched, it will also check — and inform if there is a new version
available for download; refer to chapter 8.5 for the auto-update notification.

Data update/revisions are explained in chapter 8.3.

7.5. How does FAQ assign nationality to catches?
As established by the United Nations Statistical Commission in 1954, catches are assigned to the

country of the flag flown by the fishing vessel. The flag State is also responsible for the provision of
the relevant data to FAO and other organizations such as Regional Fishery Bodies (RFBS).

7.6. Prior year numbers have changed. Why?

Refer to chapter 8.3 for a discussion on data versions.

7.7. Where to find detailed notes for each dataset?

Additional information about the statistics presented in each dataset collection are available in the
General notes, accessible in the Menu/View/Metadata/Attachments/#dataset — general notes (or by
clicking on top right button of data panel.

Refer to chapter 5.6Error! Reference source not found. for viewing dataset notes.
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7.8. FishStatJ is being flagged as a virus threat

There have received various reports that FishStatJ software has been falsely identified as being a
virus threat. We try very hard to produce FishStatJ, and we would not knowingly distribute an
infected version.

Wikipedia defines a false-positive as a false alarm
https://en.wikipedia.org/wiki/False_positives_and_false negatives.

If you receive such alert, we suggest the following actions, in the following order:

e Please send us an e-mail (Fish-Statistics-Inquiries@fao.org), describing the anti-virus
software used, and the alert message received (this way we can double-check your
download, and also warn other users).

e Please inform you virus software vendor and notify them of the ‘false positive” indication.
The vendor can then quickly investigate (check our download) and release an update to their
virus definitions (definitions are patterns to detect infected software).

e If you think FishStatJ is corrupted, the best is to re-download and expand a fresh copy.

NEVER - consider deactivating your virus protection because that would be irresponsible in this
digital age!

The MacOS version is digitally signed, as such will not launch when tampered. This provides an
additional layer of security (refer to chapter 1.3 for Mac security).

Page 65 of 68


https://en.wikipedia.org/wiki/False_positives_and_false_negatives

FishStatJ Manual

Version 3.03.2
Nov 2017

8. More on FishStatJ
8.1. FishStatJ legal specifications

The FishStatJ software is provided free of charge to member countries of the Food and Agriculture
Organization (FAO). It may be installed on personal or company computers without restriction or
license. The statistics contained in this package may be used and published freely provided that
the source is cited as FAO.

8.2. Bibliographic citation

FAQ encourages the use, reproduction and dissemination of material in this information product.
Except where otherwise indicated, material may be copied, downloaded and printed for private
study, research and teaching purposes, or for use in non-commercial products or services, provided
that appropriate acknowledgement of FAO as the source and copyright holder is given and that
FAQ’s endorsement of users’ views, products or services is not implied in any way.

All requests for translation and adaptation rights, and for resale and other commercial use rights
should be made via www.fao.org/contact-us/licence-request or addressed to copyright@fao.org.

When quoting FishStatJ data, please use the reference that you can find in the General Notes
attached to each dataset (FishStatJ menu: View/Show metadata/Attachments).

The citation for each dataset is available for copy/paste under the citation icon:
ﬂ Il_l “‘!! - E

':':I Global aguaculture production - Citation

—

The bibliographic citation for FishStatJ is as following:

FAO Fisheries and Aquaculture Department, Statistics and Information Service
FishStatJ: Universal software for fishery statistical time series. Copyright 2017.
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8.3. Data versioning and Data revisions

Where necessary the data published in the previous releases of the dataset(s) of fishery and
aquaculture statistics are revised.

Where figures in this release differ from those previously published, the amended data represent the
most recent version. Some statistics provided to FAO by national offices, in particular those for
most recent year, are provisional and may be amended in future editions.

The version and revision of the data installed, and version/revision of data available for download
are visible in the Browse workspace menu; refer to chapter 2.1.

For example the version is “2017.1.0”

Major version: is the year when the data was released (2017)
Minor version: is the release (1) and revision number (0)

Occasionally, we find errors, or we receive data from member countries after the release of the
FishStatJ workspace. In these rare cases, we release a new revision of the data by increasing the
revision number. This way, the new version is automatically visible in the workspace browser as a

new download. In this case, we would also include an explanation in the dataset notes; refer to
chapter 5.6 how to view dataset notes.

8.4. Un-installing FishStatJ

FishStatJ is un-installed by deleting the FishStatJ application folder (macOS: the application icon).

FishStatJ stores imported workspaces (and application files) in the user home directory; these can
be deleted as well:

e For Windows enter “%oUSERPROFILE%/fishstatj workspace in the Run menu
e For OSX Finder enter ~/fishstatj workspace in Go->Go to Folder menu

FishStatJ is a cross-platform application and therefore does not use the Windows-registry, it stores
all data and settings in the user home directory as described above.
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8.5. FishStatJ Auto-update

Starting with version 3.01 FishStatJ has automatic update capability built in. At program launch a
very small file (~1KB) is read from the FAO web-site (http://www.fao.org).

If there are updated workspaces available, they will automatically appear; please refer to Browse
workspace.

When we release a new version of FishStatJ, you will see the following message at program startup:

=< Mew version Fish5tat] @

I.é.l There is a new FishStat) v3.00.2 available. Open the web-page 7

e J

Clicking the Yes button will open the FishStatJ web-page in the web-browser where program
updates can be downloaded.

Refer to chapter 7.4 for an explanation of how the internet connection is used; and what data is
being downloaded.

The first time when opened — or when a new version is available, the PDF manual is downloaded
from www.fao.org. Refer to chapter 6.3 for how to open the FishStat) manual.

8.6. Assistance and Contact

On the FishStatJ web-page (http://www.fao.org/fishery/statistics/software/fishstatj/en) you can find

New program versions for download

A quick-start guide for installing the program

The download link to this manual

The e-mail contact for support (Fish-Statistics-Inquiries@fao.org)
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